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Introduction

Summary of KIPAS 2  
functions

The KIPAS 2 workshop software can be used 

• to print test certificates, installation and constant plaques
• to create report summaries

• to manage customer and vehicle data 

• to monitor inspection schedules
• to download mass memory data from digital tachographs, archive and 

save it for the customer using a workshop card and

• display and archive the data stored on the workshop card. 

So that this can be done quickly and easily, you can use KIPAS 2 to read in 
data directly from 

• the workshop card

• Service Diagnostic Systems, such as CTC, MTC and ATC
• a notebook 

• a Downloadkey.

Test certificate forms Special forms with self-adhesive installation and constant plaques are 
available for printing test certificates with KIPAS 2.

In addition, you can use KIPAS 2 to access the KIPAS 2 and Downloadkey 
operating instructions directly.

Data protection The Data Protection Act requires personal data to be protected from 
fraudulent use by third parties. Any infringement of the Data Protection Act will 
be prosecuted.

If you use a DP system for recording, processing and storing personal data 
electronically, you are obliged to comply with the Data Protection Act. 

Data backup Regular data backups – at least once a day in machine readable form – 
ensure that data can be restored without incurring too much work.

Users are responsible for backing up data. 

Important
Appropriate technical and organisational measures should be taken to protect 
personal data stored in KIPAS 2 against unauthorised access.
TU00-0880-5011102 © Siemens VDO Trading GmbH 1
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Operating mode, licence and signature

Demo mode After installation KIPAS 2 runs in demo mode where mass memory data 
archiving, import and export, analyses and print functions are disabled. With 
these restrictions KIPAS 2 can be used for an unlimited time. After creating 
the activation request, these functions are enabled for a period of 2 weeks (full 
mode). 

Full mode and activation 
request

KIPAS 2 must be licensed to run in full mode permanently where all functions 
are enabled. 

With the activation request (under Change workshop data) you can apply for a 
licence.

In full mode you can continue working with the data entered in demo mode 
without any restrictions. 

Licence The licence switches KIPAS 2 to full mode permanently. The program runs in 
this mode unless the workshop data has changed. 

• The (first) KIPAS Licence Card will be sent to you by post. 

• Licensing information is read in using the chip card reader (Software 
licensing) and KIPAS 2 switches to full mode.

Signature The signature temporarily switches KIPAS 2 from demo mode to full mode for 
14 days. The signature is provided in exceptional cases only. 

• It consists of 4 x 8 characters and is entered into the boxes provided for 
this (Change workshop data) and saved. 

• Extension (Edit workshop data) requests a new signature with which you 
can extend the temporary full mode by another 14 days. 

Reactivation mode Modified workshop data must be confirmed with a new licence that you must 
apply for. Once the activation request has been created, KIPAS 2 switches to 
reactivation mode for 14 days.

You can continue working using the saved data (customers, inspections etc.). 
Until the new licence has been entered, the previous workshop data is printed 
on the documents.
TU00-0880-5011102 © Siemens VDO Trading GmbH 2
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Installation

Requirements

Preparation • Log on to the operating system as an administrator (with all access 
rights). 

• Back up the KIPAS database before installing any updates. 
• Close all programs that are still open, especially any active virus 

scanning software and services that are not needed.

Component Minimum requirement Recommendation

Operating system Windows NT4.0, 2000 
and XP including the 
latest service packs

Windows XP with the 
latest service pack

Processor 650 MHz 2000 MHz

Free hard disk space approx. 500 MB 1 GB

Available RAM 384 MB 512 MB 

Serial ports 1 2

USB port not compulsory 2

CD ROM drive 1 1

CD burner 1 1

ZIP drive optional optional

Hard disk mobile rack optional optional

Chip card reader included in the delivery 
schedule

Screen resolution 1024 x 768 
(17" CRT / 15" TFT)

1024 x 768 
(17" CRT / 15" TFT)

Mouse standard optical with scroll wheel

Internet / Extranet connection Modem / ISDN LAN / DSL

Printer Inkjet or laser printer Laser printer

National laws may require additional peripheral devices.

Important
The software can only be licensed and used with the chip card reader 
included in the delivery schedule. Please contact your service partner if you 
need an additional chip card reader.

Important
Depending on the installation type (initial installation, update), the computer will 
restart up to three times. Do not remove the installation CD-ROM from the 
drive at this point. 

Installation is complete when the operating system has restarted completely. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 3
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Installation 1. The KIPAS 2 installation CD-ROM will start automatically when it is 
inserted into the drive. The installation program will first check the 
installation conditions and then display the installation screen.

If the operating system's Autorun feature is disabled, start the installation 
by clicking on "(CD drive):\setup.exe" in Windows Explorer. 

Setup

2. Click on Setup to start the installation program. 

The installation environment will be checked and initialised.

Dialogue language

3. The dialogue language selected only applies to the user interface 
language during installation. Click on [OK] to confirm the selected 
language. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 4



KIPAS 2
Installation and Quick Reference Guide  Installation

K
IP

A
S

 2
 - 

Ed
iti

on
 0

5/
20

07
4. The Installation wizard will guide you through the installation procedure. 
Click on [Next] to confirm any dialogue boxes and entries made. 

Installation type

5. Complete installation is the standard installation option when installing 
the software on a single workshop computer. It must also be selected if an 
earlier KIPAS 2 complete installation is available.

The Client installation option must be selected if an earlier KIPAS 2 Client 
version is installed. The Client or Server installation option must be 
selected if you want to install the database and the application server 
separately from the program. 

Country-
specificKIPAS 2 version

6. If you select a country, the KIPAS 2 country-specific version will be 
installed. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 5



KIPAS 2
Installation and Quick Reference Guide  Installation

K
IP

A
S

 2
 - 

Ed
iti

on
 0

5/
20

07
MDAC

7. If the installation routine detects an earlier MDAC version, this version will 
be overwritten by the new one. 

While MDAC is being installed, the computer is restarted automatically. 
After you have logged on to the operating system, the KIPAS 2 installation 
routine will start again automatically. 

Do not remove the installation CD-ROM from the drive at this point. 

JBoss application 
server

8. If the installation program detects an earlier JBOSS version, you must 
confirm the message asking you if want to install the new application 
server with Yes, install it. 

Important
Steps 8 to 10 need not be carried out when installing the program for the first 
time.
TU00-0880-5011102 © Siemens VDO Trading GmbH 6
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MSDE

9. The MSDE password must only be entered if a database from another 
application is installed. You must enter the administrator password for this 
database. 

New KIPAS 2 
installation

10. This message is displayed if KIPAS 2 is already installed. It must be 
confirmed with [OK] to continue with the installation process. 

By doing this, the seal number and the KIPAS 2 configuration settings 
(Options) will be reset and must be set again when installation is complete. 
Click on [OK] to confirm the message. 

Already saved data relating to customers, vehicles, inspections and mass 
memory downloads will not be lost. 

Installation folder

11. The default folder "C:\Programs\KIPAS2" or "C:\Program Files\KIPAS2" 
can be modified if necessary. 

To select a different folder click on [Select…]. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 7
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Installation 
configuration

12. Click on [Install] to start the installation process.

The files will be extracted and installed. Depending on the installation type 
and size, this can take some time. The process must not be aborted and 
the installation CD-ROM not be removed from the drive. 

13. To complete the installation the computer must be restarted by clicking on 
[Done]. 

Do not remove the installation CD-ROM from the drive at this point. 
Installation is complete when the operating system has restarted 
completely.

Then the operating system will be 

- restarted for installing MDAC and 
- restarted again to continue installing the other components 

automatically.

Important
If one of the above requirements is not met, a message will appear telling you 
that the installation process will be cancelled. When the causes for this are 
remedied, the installation process can be started once again.

Important
If the option "No, I will restart my system myself" is selected, the KIPAS 2 
installation is not yet complete and the program cannot be started. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 8
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Logging on to the 
operating system

14. When MDAC is installed you must log on to the operating system. 

The installation process will continue automatically – the screen for 
selecting the dialogue language will be displayed once again. 

Dialogue language

15. The dialogue language selected only applies to the user interface 
language during installation. Click on [OK] to confirm the selected 
language. 

16. If the program has been installed successfully, Installation complete will 
be displayed. Click on [Done] to confirm. 

The operating system will restart completely. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 9
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Startup

Initial installation 1. Start the program using the standard start routine, e.g. Start > All 
Programs > KIPAS 2 > KIPAS 2. 

2. Confirm the message that staff data is already available with [OK]. 

3. You are asked whether staff data has already been entered. Click on [No] 
as KIPAS 2 has been installed for the first time. 

The login dialogue will be displayed automatically. So that you can log on 
for the first time, an administrator with the login data below is created by 
default:
- User name: admin
- Password: admin

4. Click on [OK] to confirm the login data entered. 

The Edit workshop data dialogue box will open. 
Then you must 

- enter the workshop data,
- enter the details for at least one employee,
- create an activation request and send it to your service partner. 

Update installation Please refer to "Starting the program after an update"on page 13. 

Workshop data

"Workshop" tab • All mandatory fields (yellow) must be filled in.
• Seal number, Workshop name, Address and Phone number of the 

workshop where the computer is located. 

• Click on [Save] to save the data entered. 

Staff data

You must create at least one employee. All created employees are entitled to 
enter inspections. Employees who enter digital tachograph data must have 
been created and a workshop card assigned to them. 

"Personnel" tab • All mandatory fields (yellow) must be filled in.

• User name: This is the name the user enters to log on to KIPAS 2. 
Duplicate entries are not possible; if employees' names are identical, enter 
the first letter of the first name to distinguish them for example. 

• Card number: This number must be entered so that the user can log on 
with his workshop card and check digital tachographs. 

Important
Workshop data is printed on the documents, e.g. on the test certificate. 
Therefore, it must be entered correctly without fail.
TU00-0880-5011102 © Siemens VDO Trading GmbH 10
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• If the employee already has a workshop card, staff data can be read by 
clicking on [Workshop card]. The date of birth and a temporary password 
must be entered. This will then be modified by the workshop employee. 

• Password: The password may consist of any number of characters. The 
password is case-sensitive. Normally, it consists of letters and figures. 

• Starting date: This date must be entered. All other group details under 
Staff history are optional. 
For the date enter figures only. Two and four figures are permitted for the 
year. Spaces are not permitted. 

 Click on this button to save any data entered. 

Click on this button to enter other employees' details. 

Tools > Change 
password

Select this command if you wish to change the password. 

Licensing

Activation request You must send an activation request including the workshop data to your 
service partner to receive the Licence. 

• Click on [OK] to generate the activation request. 

• When the data is entered, you will be asked how you would like to send it:

- Export will create a file that can be sent by e-mail. 
- Fax will create a printout. 

• With the activation request you request a KIPAS 2 licence (KIPAS Licence 
Card). Prior to this, a signature will only be sent to you in exceptional 
cases. 

Unlocking KIPAS 2 • The KIPAS Licence Card is inserted into the chip card reader. Select 
Tools > Software licensing to apply the licence.

• In the Edit workshop data dialogue box enter the signature (4x 8 
characters) into the boxes under Signature and save it by clicking on 
[Save]. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 11
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Setting up KIPAS 2 

Tools > Options: After installation the KIPAS administrator should check the settings for 
connected devices and applications: 

"General" tab • Downloadkey: Assigns a drive letter to the port used to access and 
download the Downloadkey. 

• CD-Writer: Assigns the CD burner drive so that mass memory data can 
be written to a CD-ROM to be handed out to the customer or database 
backups be created.

• Acrobat Reader: Shows the path to the program file. By default, Acrobat 
Reader is installed in "C:\Programs\Adobe\Reader\ AcroRd32.exe" or 
"C:\Program Files\Adobe\Reader\AcroRd32.exe". 

• Web browser: Shows the path to the program file. By default, Microsoft 
Internet Explorer is installed in "C:\Programs\Internet Explorer\ 
iexplorer.exe" or "C:\Program Files\Internet Explorer\iexplorer.exe". 

 • This button opens the dialogue box where you can set the path.
• [Test]: Checks the set path and starts Adobe / Acrobat Reader or the Web 

browser. 

"Printer" tab • [Test print]: Enables the test certificate to be printed using sample data. 

• The values for  Top margin / Left margin  specify the position of printed 
text on the test certificate or installation plaque. 

"Tachographs/Test 
devices" tab

The Tachograph and  Test devices configuration options enable you to read 
data directly from a connected tachograph, test device or the Downloadkey. 

• Under Tachograph configuration configure the COM port on the 
workshop computer used to download DTCO 1381 mass memory data 
directly. 

• Under Test device configuration configure the workshop computer to 
read in data directly from a connected test device (SDS device). 

- If you want to connect an SDS device, you will have to make a new 
connection cable or modify a printer cable.

- The connection cable must not be longer than 20 metres to avoid data 
transmission errors.

 Click on this button to reset the settings to their default values. 

• Under Chip card reader select and accept the connected reader unit. 

"Database backup" tab • Under Database backup specify when the database is to be backed up. 
• Under Enable database backup specify the backup path and the backup 

start time.
TU00-0880-5011102 © Siemens VDO Trading GmbH 12
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Starting the program after an update

Start > All Programs > 
KIPAS 2 > KIPAS 2

1. The program can be started using the standard start routine. Links from 
the previous installation will be copied. 

2. Confirm the message that staff data is already available with [OK]. 

3. Enter the Seal number and confirm with [OK] when the program asks you 
whether workshop data has already been entered. 

4. You are asked whether staff data has already been entered. Click on [Yes] 
as an earlier version of KIPAS 2 was installed.

5. The KIPAS administrator logs on using the login details below:

- User name: admin
- Password: admin

6. After login he should first check the program settings under Tools > 
Options. 

Important
If you do not confirm the messages correctly, the program will not start. Then 
KIPAS 2 can be started again to confirm the messages correctly and /or 
completely. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 13
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Working with KIPAS 2

User interface

General program 
operation guidelines 

Main window buttons 

Dialogue box buttons  

Selecting boxes Boxes can be selected by clicking with the mouse or pressing 
the [Tab] key to move from one box to the next.

Coloured boxes Coloured boxes and list boxes are mandatory fields. 

If boxes are not coloured (optional fields) entering data is 
optional.

Dimmed boxes and 
buttons

Dimmed boxes and buttons with grey print are not available 
for the current program task.

Quick Info 
(Quick Info) 

A Quick Info will be displayed when you rest the mouse 
pointer on an element briefly. 

Toolbar buttons Toolbar buttons enable you to work with KIPAS 2 quickly and 
easily.

Log on to KIPAS 2 
(File > Login)

Open customer management 
(Checks > Customer 
management)

Create a new test certificate 
(Checks > New)

Help for KIPAS 2 
(? > Help for KIPAS 2)

Open a test certificate 
(Checks > Open)

New data record Go to first data record

Delete or cancel data record Show previous data record

Cancel any changes made to the data 
record

Show next data record

Save data record Go to last data record

Update data record
TU00-0880-5011102 © Siemens VDO Trading GmbH 14
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Starting and closing

Starting and closing 
KIPAS 2 

Start the program using the standard start routine, e.g. Start > All Programs 
> KIPAS 2 > KIPAS 2. If a shortcut has been created in the "Autostart" folder, 
KIPAS 2 will start automatically when the operating system is being booted.

 Click on File > Close or on the relevant button in the program window's title 
bar to close KIPAS 2.

Shortcuts To start the program quickly shortcuts pointing to the program file can be 
created

• on the desktop 
• in the Quick Launch bar
• in the Autostart folder.

Generally, the KIPAS20.exe program file is located in the 
"C:\Programs\KIPAS20" or "C:\Program Files\KIPAS20" directory. 

Make sure that you copy the shortcuts into the "All Users" directory so that 
these are available to all users that log on to the operating system (please 
refer to the documentation for the operating system used). 

Logging on and logging off

Login You must log on to KIPAS 2 to access the program functions. 

• Only the KIPAS administrator has access to all the functions.
• Whenever you want to enter or edit digital tachograph data, you must log 

on with a workshop card.

• An employee can only log on with the workshop card for which he has 
been authorised. 

• If employees want to carry out any other data recording and editing tasks, 
they will only need to log on with their user name and password.

The user name and password must be entered for each login procedure.

• Click on 

- [OK] if you have logged on in the normal way
- [Workshop card] when logging on with a workshop card.

Logout Only one user at a time can be logged on to KIPAS 2. When an employee 
logs on, the previously logged on employee will be logged off automatically. 

File > Logout By logging off manually the session will be closed without closing the 
program. 

Important
When logging on with a workshop card, the card must not be removed from the 
chip card reader while data (calibration data records) is being uploaded into the 
buffer memory (when data transfer is complete, the LED on the chip card 
reader stops flashing).
TU00-0880-5011102 © Siemens VDO Trading GmbH 15
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Customer management

You use the customer management function to store and modify vehicle owner, 
vehicle and contact master data. You can enter, modify, supplement or delete 
this data if necessary. 

Checks > Customer 
management: Customer 
data tab

• The data on the Customer data tab must be entered correctly as it will be 
printed on the test certificate as the vehicle owner data. 

• Under Customer number you can enter any number but it must be 
unique. If you do not enter a customer number, KIPAS 2 will assign a 
consecutive number. Customer name and Address  relate to the 
company; staff in the customer's company will be entered on the Contact 
tab. 

"Contact details" tab • Contact details are stored in the internationally accepted format, e.g. +49 
(0) 1234 567,890 or info@customer.com.

"Contact" tab • Contact data entered for customers enable you to add an additional 
phone number or e-mail address. 
If you have not entered a contact, the Vehicle assignment tab cannot be 
selected (made available). 

"Vehicle" tab • Vehicle data must be entered correctly as it will be printed on the test 
certificate as the vehicle data.

• A dialogue box will appear telling you that the vehicle already exists in 
KIPAS 2 if the vehicle owner has changed but the vehicle registration 
number is still the same, for example. In this case, proceed as follows: 
- If no inspection is stored for the vehicle in KIPAS 2, you can delete the 

vehicle from the existing customer's record and then create it for the new 
vehicle owner.

- If inspections are already stored for the vehicle, the vehicle will be 
created again for the new vehicle owner.

• The Vehicle no. will be defined by the customer. 

• Please refer to the vehicle registration document for details to be entered 
in the VIN and up to the Registration date boxes.

• Vehicle make and Model are entered too and can be selected from the 
list when creating new vehicles. 

Deleting

Important
Deleting 

• a vehicle owner is only possible if no inspection or mass memory data has 
been stored for any of his vehicles. 
When deleting a vehicle owner for whom vehicles with and without 
inspections or mass memory data are stored, only the vehicles for which 
no inspections or download files are stored will be deleted.

• a vehicle is only possible if no inspection data has been stored for the 
vehicle (test certificates, mass memory data etc.).

• a contact is always possible. When deleting a contact, the vehicles 
assigned to him will be deleted too. 
TU00-0880-5011102 © Siemens VDO Trading GmbH 16
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Test certificates

In KIPAS 2 the recorded inspection data is used as a basis for monitoring 
schedules and creating the necessary printouts and report summaries. 

• KIPAS 2 test certificate forms can be obtained from your service partner.

• New customer and vehicle data can be entered while entering the 
inspection data. 

• Saved customer and vehicle data can be selected from the list boxes.
• Data can only be modified within 24 hours of the first data record printout 

(open test certificate). 

• You can select saved inspection data using the navigation buttons after 
selecting the customer and the vehicle. 

"Vehicle owner data" tab • Only if you have filled in the mandatory fields is the next tab made 
available. 

• When the customer and the vehicle are selected, the inspection data can 
be loaded directly into the test certificate from an SDS test device or 
workshop card (digital tachographs) by clicking on [Read in]. Details for 
the other mandatory fields must then be entered manually. 

"Tachograph data" tab • The logged in tester (technician) is copied into the Tester box 
automatically. 

• The Inspection date must be absolutely correct even if the inspection was 
performed more than 24 hours ago. The time limit for making any changes 
does not start from the entered inspection date but is calculated by the 
program from the date the test certificate was printed. 

• You can enter a new TCO device type that will then be available for 
selection in future. You must also define whether it is a digital tachograph. 

• If the tachograph is to be replaced, select the relevant option under 
Tachograph and enter the odometer reading. 

- New: A defective tachograph will be replaced by a new one.
- RAS: A defective tachograph will be replaced by a 

replacement unit.
- Repair: A defective tachograph was repaired.
By selecting the option again you can cancel the selection. 

"RSL data" tab • If the RSL inspection completed check box is selected, the boxes will be 
made available. 

• The mandatory fields below must be copied from the model plate:

- Date of manufacture
- Serial number and
- RSL control unit type designation. 

"Vehicle test" tab • If the inspection data is not read in from a rolling road bench (ATC), the 
Correction factor must be set manually. 

"Device test" tab • All mandatory fields must be filled in regardless of the tachograph type 
checked. 

"General work" tab • General work details are optional.

"Special equipment" tab • Special equipment details are optional.
TU00-0880-5011102 © Siemens VDO Trading GmbH 17
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"Service" tab • The test certificate cannot be printed if details on Defects and 
irregularities detected are missing.

- Select the None check box if no defects and irregularities were detected 
during the inspection. 

- If defects have been detected, you can add comments on the type and 
extent of the defect. 

Printing the test 
certificate

With KIPAS 2 you print the test certificate, the installation and constant 
plaques at the same time. If you have entered both inspections, i.e. the 
tachograph inspection and the RSL check, the order of the printout is as 
follows:

• Front: Tachograph inspection
• Back: Tachograph inspection

• RSL check (front only). 

Cancel test 
certificate

If, after more than 24 hours, you detect that the saved data is faulty or 
incomplete, the data record will be deleted and a new test certificate will then 
be created for the vehicle inspected. 

Mass memory data

Mass memory The digital tachograph saves the data in so-called data blocks in its mass 
memory. The data blocks can be downloaded separately. If there is a defect 
the data must be downloaded completely. 

In KIPAS 2 this data can be downloaded, archived, burned to a CD-ROM that 
is handed out to the customer or saved in a freely selectable archiving folder. 

Data that has been archived in KIPAS 2 can be retrieved from the database 
later and supplied to the customer on CD-ROM or another data carrier. Then 
the mass memory data can be deleted from the database. Please refer to 
"Deleting the mass memory"on page 20. 

Download Data can be downloaded

• from a Downloadkey
• directly from a digital tachograph.

Archiving Data is archived

• either directly on a data carrier (CD-ROM or archiving folder) or

• in the database if the data cannot be handed out to the customer yet.

Important
Please observe the archiving regulations relating to digital tachograph mass 
memory data in your country.
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Data source (Download)

File > Archive mass 
memory 

The employee must be logged on to KIPAS 2 with his workshop card to 
archive mass memory data.

The archiving procedure starts when a new data record is being entered.

"Vehicle owner data" tab • Only if you have filled in the mandatory fields is the next tab made 
available. 

• New customer and vehicle data can be entered directly. 

• Saved customer and vehicle data can be selected from the list boxes. 
"Archiving" tab • Digital Tachograph: Data from a connected digital tachograph or 

notebook will be downloaded. 

• File: Data from a connected Downloadkey will be read. If a Downloadkey 
is connected, the drive is called Downloadkey. The saved download files 
can be selected. 

• Database: Saved data will be read from the database. The desired 
download file can be selected by clicking the mouse. 

• Click on this button to choose the path if you have selected File or 
Database.

• [Start]: The data from the selected source will be read and copied to the 
clipboard. When the data has been read, the check boxes under Data 
target can be selected.

• Never remove the Downloadkey from the computer during data transfer. 
Doing this, could corrupt the data and cause the computer to crash.

Data target (archiving)

• Database: This option is selected by default. Saving the data in the 
database is not compulsory as the program will ask you whether you want 
to save the data each time an archiving procedure is started.

• Serial transfer: The data will be transferred to the workshop computer via 
the COM port, e.g. a notebook COM port. 

• CD-Writer: The data will be transferred to the CD - Writer utility so that it 
can be written to the CD-ROM directly.

• Archiving path: The directory where the data should be saved must be 
entered. The file name cannot be modified.

• [Data summary]: Opens a dialogue box where you can check the type and 
quantity of data copied to the clipboard. 

• [Archive]: Starts the data storage procedure based on the selected data 
target(s). 

Important
When selecting data to be handed out to the customer (company), you must 
make a note of the selected company entries (Lock-ins).
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Certificate of Downloadability / Undownloadability

"Download check list" 
tab

In KIPAS 2 you can create the Certificate of Downloadability or 
Undownloadability in your language. 

• The details necessary for the certificate will be copied automatically from 
the downloaded data. 

• Installation location: Relates to the tachograph installed in the vehicle. 

• A text box is available where you enter the reason why the data is 
incomplete. 

• Once the data has been saved, the print function is made available.

Deleting the mass memory

File > Delete mass 
memory 

This command will delete the mass memory data when it has been handed 
out to the customer or when the required archiving period has elapsed.

The file name in the Download file column indicates when the data was 
downloaded (date and time), the vehicle registration number and vehicle 
identification number.

Downloadkey configuration

You can use KIPAS 2 to configure a Downloadkey for data transfer between 
digital tachographs and KIPAS 2. 

By configuring the Downloadkey you define which digital tachograph data 
should be copied and saved for archiving and analysis. 

The configuration procedure is described in detail in the Downloadkey 
operating instructions.

Important
Please observe the archiving regulations relating to digital tachograph mass 
memory data in your country.
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CD – Backup

This utility enables you to burn mass memory data directly from KIPAS 2 
(Archive mass memory) or scheduled backup copies of the KIPAS 2 database 
to CD-ROM. CD – Backup will start and close automatically together with 
KIPAS 2.

• Source path: The directory where the database backup copies should be 
saved must be entered.

• CD – Writer: Specify the drive to which the CD burner is connected.

• Time interval: Interval in which the program checks whether new backup 
files are available. These files are then burned to a writable CD-ROM in 
the CD burner.

• CD-Writer state: Displays text information on the individual burning 
phases.

• Last message: Indicates whether the burning process was successful or 
not.

Glossary

JBoss JBoss application server: Application server based on the J2EE standard. 
JBoss: Java workflow engine.

MDAC MDAC = Microsoft Data Access Components: Summary of components used 
for data access connections. KIPAS 2 requires at least version 2.7.

MSDE MSDE = Microsoft Desktop Engine (also called Microsoft Database Engine): 
SQL server version with limited database management functions. 

VNC VNC = Virtual Network Computing: Software with which, after a query, a local 
computer can be accessed by a remote computer. (Installed for remote 
maintenance purposes.) 
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